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Описание применения

1. Введение

Мост SILVERRUN-RDM<->JAM - это программный продукт для переноса схемы базы данных и экранных интерфейсов между CASE-средством SILVERRUN-RDM и языком 4GL JAM версии 7.0.

Данный программный продукт имеет 2 режима.

1. Прямой (SILVERRUN-RDM->JAM): предназначен для создания объектов CASE словаря и элементов репозитория в JAM на основе представления схем в SILVERRUN-RDM.

Мост преобразует таблицы реляционной модели данных (RDM) в последовательность объектов JAM соответствующих типов, а отношения между таблицами - в объекты JAM типа “Link”. По описанию каждой из подсхем RDM генерируется экранная форма JAM.

2. Обратный (JAM->SILVERRUN-RDM): предназначен для переноса модификаций объектов CASE словаря в реляционную модель SILVERRUN-RDM.

На рисунке 1 представлена схема взаимодействия SILVERRUN-RDM и JAM.
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Рис. 1. Схема передачи информации между SILVERRUN-RDM и JAM

В данном описании отсутствуют определения понятий информационной и функциональной моделей и инструкции по использованию JAM.  Предполагается, что пользователь знаком в достаточной степени с SILVERRUN-RDM и JAM из соответствующей документации. 

Для корректного взаимодействия с JAM в SILVERRUN-RDM необходимо выполнить ряд операций:

- произвести генерацию сокращенных имен для всех понятий схемы и проекта;

- произвести генерацию базовых типов и доменов для JAM;

- с помощью ODBC драйвера записать схему и проект в выбранную СУБД.

В качестве СУБД может быть выбрана любая база данных, имеющая ODBC драйвер. Для работы моста используется СУБД, имеющая формат файлов DBF.

Примечание: версия SILVERRUN Enterprise RDM автоматически обеспечивает хранение репозитория RDM в СУБД Oracle. Для этой версии может быть произведена настройка моста на формат СУБД Oracle.
Прямой мост переносит данные из формата СУБД в словарь JCD (JAM CASE Dictionary) (см. рис.1). Доступ к словарю JCD обеспечивается непосредственно из меню JAM.

В JCD-словаре хранятся объекты следующих типов: подсхема (subschema), таблица (table), поле таблицы (fld), отношение (link).  Эти объекты могут быть импортированы в экраны JAM с соответствующим набором свойств.

Некоторые свойства объектов JAM могут быть заданы в RDM с помощью определяемых пользователем полей (User-Defined Fields - UDF),  предусмотренных в SILVERRUN-RDM.  UDF автоматически генерируются в SILVERRUN-RDM на основании описаний из файла ‘jam_sr24.typ’ при выполнении генерации базовых типов (пункт меню “Generate base types and domains ...”).  Для версии SILVERRUN-RDM  2.3 используется файл jam_sr23.typ.
Установка моста SILVERRUN-RDM<->JAM.

· установите первый диск из дистрибутива моста в дисковод a: или b:;

· из среды Windows выберите пункт “Run…” в меню “File”;
· укажите имя дисковода;
· по требованию программы установите второй диск.

По окончании установки будет создана группа программ с именем JYACC и иконками для приложений SR-RDM<->JAM Bridge и JAM/CASEi for SR.  Для версии SR-RDM 2.3 скопируйте файл jam_sr23.typ в подкаталог DBMS.  Для  версии SR-RDM 2.4 нужно скопировать файл jam_sr24.typ в подкаталог TARGET_S.
Примечание: Для работы с внешними схемами из SILVERRUN-RDM необходимы ODBC драйверы версии Q+E v.1.1. Мост использует драйвер “INTERSOLV Explorer dBASEFile (*.dbf)”, входящий в комплект программного продукта INTERSOLV Data Direct Explorer.
2. Функция прямого инжиниринга: перенос данных из SILVERRUN-RDM в JAM

2.1. Подготовка модели данных в SILVERRUN-RDM.
1. Загрузите в SILVERRUN-RDM выбранную для переноса в JAM реляционную модель данных.

2. С помощью пунктов “Generate Coded Names...“  в меню “Project”  и “Schema” произведите генерацию кодовых имен для проекта и всех его схем.

3. Далее на уровне проекта в SILVERRUN-RDM нужно произвести генерацию базовых типов и доменов, соответствующих типам JAM. 

Для этого выполните следующие действия:

1) выберите пункт ‘Target Systems’ из меню ‘Project’ (в версии SR-RDM 2.3 выберите пункт "Generate Base Types and  Domains ....");

2) с помощью кнопки ‘Avail. Target Sys.’ произведите выбор пункта ‘JAM7.TYP’ в списке названий допустимых систем и нажмите кнопку ‘ADD’ (в версии SR-RDM 2.3  с помощью кнопки 'Open...' укажите файл  ‘jam_sr23.typ’,  содержащий нужные параметры);

3) сделайте выбор нужных опций в соответствии с рисунком 2 и нажмите кнопку "Generate".
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Рис. 2. Экран генерации базовых типов для JAM

Установка последних трех флагов является наиболее распространенным вариантом конфигурации параметров для большиства моделей. Последний флаг может быть отключен, если не используются UDF. После выполнения генерации список базовых типов для JAM можно просмотреть с помощью пункта “Base Types” меню “Project”.

Список базовых типов для JAM представлен на рис.3.
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Рис. 3. Список базовых типов JAM

В результате выполнения генерации базовых типов в SILVERRUN-RDM, имеющем мост для передачи данных в JAM, на уровне проекта и схемы автоматически генерируются определяемые пользователем поля (UDF), соответствующие основным свойствам JAM.

На рисунке 4 представлены UDF на уровне проекта. Этот список можно получить с помощью меню “Project” -> “User Defined Fields”.

На рисунке 5 представлены UDF на уровне схемы проекта. Этот список можно получить с помощью меню “Model”->”User Defined Fields” (в версии SR-RDM 2.3  “Schema” -> “Root” -> “User Defined Fields”).

UDF служат для переноса из RDM специфичной для JAM информации. Так, например, формат размещения данных текстовых полей, цветовые атрибуты или строка подсказки при получении полем фокуса могут  быть заданы с помощью UDF. При переносе схемы в JAM мост преобразует эти поля в свойства объектов JAM.

Работа с JCD предполагает ряд ограничений для CASE-объектов: имена не должны начинаться с цифры, не должны содержать каких-либо скобок, имя подсхемы не может совпадать с именем основной схемы; допускаются русские имена для полей таблиц, но имена самих таблиц и имена схемы и подсхем не должны содержать русских букв.
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Рис. 4. Список определяемых пользователем полей (UDF) для доменов, задаваемых на уровне проекта.
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Рис. 5. Список определяемых пользователем полей (UDF) для полей таблиц, задаваемых на уровне схемы.

Примечание: можно добавить в качестве дополнительных UDF любые другие свойства JAM. Для этого достаточно отредактировать файл jam_sr24.typ (jam_sr23.typ для версии 2.3 SR-RDM) или создать на его основе файл описаний типов с другим именем. В этом файле можно также указать значения, используемые по умолчанию. Поскольку большинство значений свойств по умолчанию автоматически определяются в JAM, данная функция может быть полезна для определения значений, отличных от принятых по умолчанию в JAM. Аналогичным образом может быть изменен и список базовых типов JAM.

4.  Внесите в соответствующие UDF необходимые значения для полей таблиц или доменов, определяющие свойства объектов в JAM.
5.  В случае необходимости использования русских названий для объектов экрана можно определить псевдонимы имен в поле ‘Alias’  в окне ‘Column Description’ для колонок таблиц в подсхемах. 

6. Произведите выгрузку схемы с подсхемами в формате выбранной СУБД. Для этого выполните следующие действия:

1) установите связь с базой данных, в которую будет импортироваться информация из проекта, с помощью меню “Util”->”Metadata Warehouse” (в версии SR-RDM 2.3 “Util”->“DBMS”->“Connections...”); в настоящее время используется формат “.dbf” (dBASE files);

2) создайте структуру базы данных через меню “Util”->“Metadata Warehouse”->“External Schema...”->“Generate”;

3) сохраните модель в базе через меню “Util”->“Metadata Warehouse”->“SAVE...”.

Примечание: функция создания схемы базы данных занимает длительное время. При выводе нескольких моделей из SILVERRUN работу можно ускорить, скопировав структуру БД с помощью операции копирования файлов в ДОС.

2.2. Порядок работы с мостом SILVERRUN-RDM<->JAM в режиме прямого инжиниринга.

Перед запуском моста SILVERRUN-RDM<->JAM в среде Windows введите, если это необходимо, новый источник данных, связанный с ODBC-драйвером для dBASE файлов. Эту операцию можно выполнить и во время работы с мостом.

Примечание:  При передаче русских заголовков необходимо включить режим ‘OEM to ANSI’ с помощью кнопки ‘Translate…’ в окне ODBC Driver Setup при формировании нового источника данных.

1. Запустите программу-мост SILVERRUN-RDM<->JAM в среде Windows, выбрав соответствующую иконку в группе “JYACC”.

2. Выберите пункт "Forward Engineer” из меню "File". е

3. С помошью меню опций “Descriptor Used” укажите тип используемых имен: полные, сокращенные или псевдонимы (‘Alias’).


4. Для проверки корректности модели нажмите кнопку 'Validation' (подробное описание этой функции приведено в разделе функция 'Validation').

5. Если схема не содержит ошибок, нажмите кнопку "Generate".

Примечание: можно нажать кнопку "Generate" без предварительного выполнения функции 'Validation'. Тогда будет предложено выполнить эту операцию или отказаться от нее.

6.  Укажите источник данных, содержащий информацию об RDM-схеме для переноса в JAM. Если источник данных не выбран, операция генерации прекращается. Здесь же можно определить новый источник данных с помощью кнопки ‘New…’.



7.  Задайте имя JCD-словаря, в который будет произведена запись объектов и свойств JAM.


Если в качестве имени JCD-словаря выбран файл, с уже записанной RDM-моделью, то появится сообщение:



При утвердительном ответе все объекты из словаря будут удалены и модель будет записана в пустой словарь с указанным именем. В случае отмены операция генерации прекращается, поскольку не допускается запись нескольких моделей в один словарь.

Примечание: все понятия в RDM-схеме должны иметь полные и сокращенные имена, а значения полей UDF соответствовать одному из допустимых значений для одного из свойств JAM.

На следующем рисунке представлен экран, содержащий информацию о завершении преобразования CASE-объектов в JCD-словарь. В нижней части экран находится динамический индикатор, показывающий текущую стадию работы моста.



2.3. Функция проверки правильности данных ('Validation').

Проверка данных осуществляется с точки зрения их корректности как объектов и свойств JAM.  Сообщения,  получаемые  при выполнении функции 'Validation', являются лишь предупреждением о возможных неточностях в преобразовании данных или неполноте определения понятий в RDM. Даже в случае обнаружения неточностей и ошибок функцией 'Validation', JCD-словарь по требованию пользователя может быть  сгенерирован.

В окне, открывающемся при выборе пункта меню 'Forward Engineer', нажмите кнопку 'Validation' и введите имя файла описаний типов (jam_sr24.typ или jam_sr23.typ для версии 2.3 SR-RDM) и имя текстового файла, в который будет производиться вывод сообщенний об ошибках. Если по завершении проверки получено уведомление 

'The validation file contains errors or  warnings for this schema', 

то следует просмотреть файл сообщений. Для этого воспользуйтесь пунктом "View a Text File..." в меню "Utility". 



При создании JCD-словаря осуществляется проверка реляционной модели данных, переносимой из SILVERRUN-RDM, на основании описаний базовых типов и UDF, задаваемых в файле ‘jam_sr24.typ’ (или ‘jam_sr23.typ’ для версии 2.3 SR-RDM).
Функцией ‘Validation’ производятся следующие проверки.

При отсутствии имени или  сокращенного  имени для одного из понятий схемы RDM выдается сообщение:

"Name or coded name is not specified."

При отсутствии сокращенного имени объекта указывается его полное имя. Сообщается также имя соответствующей схемы или подсхемы.   В этом же сообщении может содержаться информация об отсутствии псевдонима (‘Alias’), если активизирован соответствующий пункт для генерации имен колонок таблиц.
В случае использования базовых типов, отличных от типов данных в JAM, генерируется сообщение:

"Incorrect JAM base type is used:"

Каждому домену из проекта в RDM должен соотвествовать один из базовых типов. Следует учитывать, что для доменов, ранее использованных в проекте, нужно вручную поставить в соответствие какой-либо базовый тип.

Если расстановка соответствия базовых типов не была сделана для всех доменов, то будет получено сообщение:

"Base type for domain is not specified."

При определении  значений полей UDF следует помнить,  что каждое свойство JAM принимает  ограниченный  набор  допустимых значений. Так, например, свойство "Focus protection' может принимать лишь два возможных значения:  "Yes"/"No".  При обнаружении несоответствия значений будет получено сообщение:

"Incorrect property value in UDF <property name>."

Таблица соответствия свойств объектов JAM и полей RDM модели:

	SILVERRUN-RDM
	JAM

	Table
	Table View

	Name
	Name

	
	Table

	
	Columns

	Combination Composition
	

	Column
	Primary Key

	Column
	Single line text widget

	Name
	Name

	
	Column Name

	Length
	Length

	Null value possible
	Null Field

	Base Type
	

	Name
	C Type

	
	Column Type

	
	Format Type

	
	Keystroke Filter

	Domain
	

	Minimum Value
	Minimum Value

	Maximum Value
	Maximum Value

	Validation Rule
	Edit Mask

	
	Keystroke Filter

	Combination
	Link

	Name
	Name

	Connector
	

	Child
	Child

	Direction
	

	Name
	Parent

	Combination Composition
	

	Column
	Relations


UDF for DOMAIN:

	UDF names
	JAM property names

	"Widget Type"
	"Widget Type”

	"Hidden"
	"Hidden"

	"Start Row"
	"Start Row"

	"Start Column"
	"Start Column”

	"Focus Protection"
	"Focus Protection"

	"Status Line Text"
	"Status Line Text"

	"Input Protection"
	"Input Protection"

	"Convert Case"
	"Convert Case"

	"Required"
	"Required"

	"Array Size"
	"Array Size"

	"Justification"
	"Justification"

	"FG Color Type"
	"FG Color Type"

	"FG Color Name"
	"FG Color Name"

	“Color Type"
	“Color Type"

	 “Color Name”
	“Color Name”


UDF for COLUMN:
	UDF names 
	JAM property names

	"Widget Type"
	"Widget Type”

	"Hidden"
	"Hidden"

	"Start Row"
	"Start Row"

	"Start Column"
	"Start Column”

	"Focus Protection"
	"Focus Protection"

	“Edit Mask”
	“Edit Mask”

	"Status Line Text"
	"Status Line Text"

	“Maximum Value”
	“Maximum Value”

	“Minimum Value”
	“Minimum Value”

	"Input Protection"
	"Input Protection"

	"Convert Case"
	"Convert Case"

	"Required"
	"Required"

	"Array Size"
	"Array Size"

	"Justification"
	"Justification"

	"FG Color Type"
	"FG Color Type"

	"FG Color Name"
	"FG Color Name"

	“Color Type"
	“Color Type"

	"Color Name"
	"Color Name


Списки UDF для полей и доменов  различаются  наличием 3-х дополнительных UDF для полей: “Maximum Value”, “Minimum Value” и “Edit Mask”.  Это связано с тем, что аналогичные свойства  для доменов определяются через атрибуты домена в окне “Validation Method”.
Пример использования UDF для задания свойств объектов JAM.

Свойства объектов, импортируемых в JAM, могут быть заданы как на уровне полей таблиц, так и на уровне доменов. Второй способ рекомендуется использовать для задания аттрибутов, общих для нескольких объектов JAM. При одновременном определении свойства на уровне домена и поля таблицы используется второе определение. Например, если строка подсказки "Status Line Text" для домена ”ключ” содержит значение "Identifier", то соответствующее значение будет появляться для всех полей, связанных с этим доменом. Однако для каждого экрана это свойство можно переопределить, задав ему другое значение через UDF поля таблицы.
Рассмотрим простой пример переноса свойств объектов JAM с использованием UDF в SILVERRUN-RDM.



Определим для поля client billing address из таблицы client свойства выравнивания, включения регистра больших букв при вводе и строки подсказки:

При генерации экранной формы в JAM будет создано текстовое поле с сокращеннным именем Cli_Bil_Add, а поля UDF будут интерпретированы как свойства JAM, что представлено на рисунке:



2.4. Порядок работы с программой JAM в режиме CASE ANALIST.

Для того, чтобы импортировать объекты из словаря JCD в объекты JAM, откройте его с помощью меню “File”->“Open”->“CASE Dictionary...”.

Замечание: словарь JCD должен находиться в рабочем каталоге JAM.



Затем произведите операцию импорта CASE-объектов в объекты JAM с помощью меню “File”->“Import”->“CASE Object...”.


Версия JAM для работы с CASE-средствами имеет режим “CASE ANALYST”, включающий средства графического представления структуры экрана JAM, импортированного из SILVERRUN-RDM.

В этом режиме схема объектов экрана выглядит следующим образом:



На рисунке показано, что для редактирования выбрано поле CLI_BIL_ADD, относящееся к таблице CLI_Screen1. Свойство выравнивания “Justification” импортировано из RDM и имеет значение “Right”.

В режиме “CASE ANALYST” можно редактировать свойства объектов словаря JCD. А обратный мост JAM<->SILVERRUN-RDM позволяет экспортировать данные из  измененного JCD-словаря в схему SILVERRUN-RDM.

Функция обратного инжиниринга: перенос данных из JAM в SILVERRUN-RDM
Режим реинжиниринга позволяет переносить модификации всех свойств экранов JAM, импортированных ранее из RDM, в схему SILVERRUN. На этом этапе для контроля целостности базы данных (БД) не допускаются изменения схемы в виде добавления или удаления таблиц и полей таблиц.

2.5. Порядок работы с мостом SILVERRUN-RDM<->JAM в режиме обратного инжиниринга.

1. Запустите программу-мост SILVERRUN-RDM<->JAM в среде Windows, выбрав соответствующую иконку в группе “JYACC”.

2. Выберите пункт "Reverse Engineer' из меню "File".



3. С помощью меню опций “Descriptor Used” укажите тип используемых имен (полные или сокращенные) и нажмите кнопку "Update".



4. Укажите словарь JCD, содержащий информацию об объектах JAM для переноса в схему SILVERRUN-RDM.



5. Укажите источник данных, содержащий в файлах базы данных выбранной СУБД информацию об RDM-схеме, которую Вы хотите обновить в SILVERRUN-RDM. 



Укажите файл с описанием типов данных и UDF: jam_sr24.typ или другой. На следующем рисунке представлен экран, отображающий процесс обновления информации об RDM-схеме в базе данных.



2.6. Порядок работы в SILVERRUN-RDM после обновления модели с помощью функции обратного инжиниринга.

Произведите загрузку модели в SILVERRUN-RDM из выбранной СУБД. Для этого выполните следующие действия:

1) установите связь с базой данных, содержащей информацию об обновленной RDM-модели, с помощью меню “Util”->“DBMS”->“Connections...”;

2) загрузите модель из базы данных с помощью меню “Util”->“DBMS”->“Load...”. 

Примечание:  В режиме реинжиниринга мост работает только с версиями SR-RDM 2.4. и выше. 
3. Описание работы моста на примере модели sample.rdm.
В комплект поставки моста входит файл sample.rdm, содержащий пример простой схемы из 4 таблиц связанных тремя отношениями. Модель содержит также 3 подсхемы, являющиеся прототипами экранов приложения:



Модель содержит несколько доменов, задающих атрибуты соответствующих  полей таблиц. Так,  для домена “Стоимость” задан тип ‘float’  и  определен диапазон допустимых значений. 



Домену “Телефон” соответствует тип ‘char’ и указана маска ввода 
(###) ###-##-##. 



Домены и поля таблиц имеют русские имена, но для свойств объектов JAM, используемых менеджером транзакций, необходимы имена на английском, задаваемые в ‘Alias’.  Поскольку для понятия домена  нет соответствующего аналога  в JAM, мост в режиме реинжиниринга изменяет только атрибуты полей, определяемые через UDF полей. 

В подсхеме client_scr  из модели sample.rdm для поля “Клиент Имя” заданы следующие UDF:



Пример модели sample.rdm предназначен для проверки функционирования моста  и является учебным примером для освоения его применения. Проведите самостоятельно перенос модели в JAM  и сравните полученный результат с представлением в SR_RDM.
1.  Для этого нужно выполнить следующие действия:

· сохраните модель из sample.rdm в dBASE формате (*.dbf) 
·  запустив мост SILVERRUN-RDM<->JAM создайте соответствующий ему словарь sample.jcd

·   с помощью функции импорта перенесите данные CASE словаря в репозиторий JAM
· при необходимости произведите настройку экранных форм в JAM путем изменения свойств объектов в режиме “CASE Analyst”; используя экраны репозитория можно  конструировать новые экраны приложения;

     Примечание: для работы с экранами в режиме ‘wizard’ в каждом из экранов необходимо заменить значение “@CASE” свойства наследования  на значение “@DATABASE”.

( АО “Аргуссофт Компани”          1996

Описание применения 

